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MANUAL DE USUARIO PIC PROGRAMMER 

1. INTRODUCCIÓN 
 

Electronilab.co presenta el nuevo grabador PIC PROGRAMMER para la grabación de dispositivos 

PIC de las familias 10FXXX, 12FXXX, 16FXXX y 18FXXXX, mostrado en la figura 1. Se trata de un 

circuito de reducidas dimensiones y bajo coste, apto para su empleo con los modelos PIC más 

representativos en la actualidad. 

Es ideal para la grabación de dispositivos en fase de pruebas, prototipos y productos finales. 

Tanto el hardware como el firmware interno de nuestro PIC PROGRAMMER son compatible con el 

sistema PICkit-2 de Microchip. Esto permite que, como software de control, se pueda utilizar el 

conocido entorno de desarrollo MPLAB IDE desde el cual se realizan todas las operaciones tı́picas 

en el desarrollo de una aplicación: edición del programa fuente, ensamblado, depuración y 

GRABACION. También se puede emplear el software de grabación PICkit 2. Ambos son herramientas 

de libre adquisición y originales de Microchip que se pueden descargar y/o actualizar desde 

www.microchip.com. Las pruebas realizadas por Electronilab.co. ası́ como las referencias que 

aparecen en este manual, se hicieron con las siguientes versiones: 

• MPLAB IDE V8.30 

• PICkit-2 V2.61 

2. CARACTERISTICAS GENERALES 
 

• Reducidas dimensiones: 99 x 49 mm. 

• Interface USB con el PC mediante cable Mini USB tipo B 

• Alimentación desde el propio puerto USB del PC 

• Consumo 35 mA en standby y 55mA aprox. en los ciclos de actividad (grabación, lectura, 

borrado del PIC, etc.) 

• Indicador luminoso de “ocupado” (Busy) que se activa durante cualquier ciclo de actividad. 

• Zócalo de fuerza de inserción nula universal para insertar el PIC a grabar. Admite 

dispositivos de 0.3” y 

• 0.6”, de 8, 18, 28 y 40 pines de las familias PIC 10F, PIC12, PIC16 y PIC18. 

• Selección, mediante jumper, de dispositivos de 8, 18 y 28/40 pines. 

• Dispone de conexión ICSP de 6 vıás, compatible con el PICkit-2 y que transporta las 

señales de grabación. 
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• Con esta conexión ICSP es posible emplear las señales de grabación para conectarlas a los 

múltiples dispositivos PIC de otras familias y encapsulados que, tanto el entorno MPLAB 

IDE como el software de grabación PICKit-2, son capaces de grabar. 

3. MODO DE EMPLEO 
 

La figura 1 muestra las secciones más relevantes del grabador PIC PROGRAMMER de Electronilab.co 

 

Figura 1. Partes del grabador PIC PROGRAMMER. 
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3.1. CONECTOR USB  
Se trata de un conector mini USB hembra tipo B para la conexión con un puerto USB del PC. Para 

ello se emplea un cable adaptador macho mini USB tipo B, que se incluye en el equipo. 

3.2. JUMPER SELECTOR DE VOLTAJE 
Puente para la selección de la tensión de alimentación del pic. Se puede seleccionar entre 5VDC o 

3.3VDC, dependiendo del dispositivo a programar. 

3.3. JUMPER SELECTOR DE DISPOSITIVO 
 

Permite seleccionar el no de pines del dispositivo que se desea grabar. 

Posición Dispositivo 

1 28 y 40 pines 

2 18 pines 

3 Familia 10FXXX 

4 Familia 12FXXX 

 

Nota: Es importante asegurarse de la correcta posición de este jumper, de lo contrario pueden 

provocarse daños irreparables en el PIC a grabar. 

3.4. HEADER ICSP 
 

Transporta las señales propias de grabación PGC, PGD, GND, Vcc y Vpp, distribuidas como se 

muestra en la siguiente tabla. Gracias a esas señales se puede realizar, mediante la conexión 

apropiada, la grabación de cualquier controlador PIC de las diferentes familias y encapsulados que 

admiten tanto el entorno de desarrollo. 

# PIN SENK AL DESCRIPCIO� N 

1 VPP Voltaje de programación 

2 VDD Alimentación (5V o 3.3V) 

3 GND Tierra 

4 PGD Señal de Datos 

5 PGC Señal de Reloj 

6 AUX Señal auxiliar 
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3.5. ZÓCALO ZIF DE INSERCIÓN 
 

Se trata de un zócalo de fuerza de inserción nula (ZIF) donde se inserta el dispositivo a grabar. Es 

un zócalo universal que admite encapsulados de 0.3” y de 0.6” con 8, 18, 28 y 40 patillas de las 

familias PIC10, PIC12, PIC16 y PIC18. 

La serigrafıá de la placa muestra claramente la orientación que debe tener el pin no 1 del PIC (Fig.2). 

Los dispositivos de 8 pines se colocan en la parte posterior dependiendo de la familia. Si son de la 

familia PIC12F se colocan en la parte posterior rotados 90°, si son de la familia PIC10F, se colocan 

donde indica la serigrafı́a, sin rotar. El resto de dispositivos de 18, 28 y 40 pines se colocan en la 

parte anterior, empezando siempre por el primer pin del zócalo zif. La secuencia de imágenes de la 

figura 3 muestra la ubicación de los diferentes encapsulados admitidos: 

 

a) Dispositivos de 28 y 40 pines. El jumper de selección de dispositivo en posición 1. 

 

 

 

Figura 2. Posición de los dispositivos de 40 y 28 Pines. 

 

 

 

Jumper en 
posición 1 

Jumper en 
posición 1 



ELECTRONILAB.CO 
 

Página 7 

b) Dispositivos de 18 pines. El jumper de selección de dispositivo en posición 2. 

 

 

Figura 3. Posición de los dispositivos de 18 Pines. 

c) Dispositivos de 8 pines de la familia PIC10FXXX. El jumper de selección de dispositivo en 

posición 3. 

 

Figura 4. Posición de los dispositivos de 8 Pines Familia 10FXXX. 

d) Dispositivos de 8 pines de la familia PIC12FXXX. Este dispositivo va rotado 90°, es decir que 

el pin 1 del PIC va en el pin 21 del zócalo zif, como se aprecia en la serigrafı́a de la tarjeta. El 

jumper de selección de dispositivo en posición 4. 

 

Figura 3. Posición de los dispositivos de 8 Pines Familia 12FXXX. 

Jumper en 
posición 2 

Jumper en 
posición 4 

Jumper en 
posición 3 

Dispositivo 
rotado 90° 
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4. EL ENTORNO DE DESARROLLO MPLAB-IDE 
 

Se trata de un software de libre distribución original de Microchip que se puede descargar y/o 

actualizar desde www.microchip.com. Es conveniente hacerlo de forma periódica con objeto de 

obtener la última versión disponible donde se van corrigiendo los fallos y errores encontrados en 

versiones previas. Se descarga un fichero ZIP que contiene los archivos ejecutables, archivos de 

configuración, lenguajes, etc. El proceso de instalación es totalmente automático y basta con seguir 

las instrucciones. A la hora de escribir el presente documento hemos empleado la versión MPLAB 

IDE V8.30. 

Tanto en el mercado como en la red podemos encontrar gran cantidad de herramientas software, 

lenguajes y aplicaciones dedicadas a los microcontroladores PIC. Sin embargo, el entorno MPLAB 

IDE es la herramienta software original, fundamental y de referencia que propone Microchip para 

el desarrollo de aplicaciones basadas en sus controladores. En Ingenierı́a de Microsistemas 

Programados, aunque no podemos proporcionar su soporte técnico, la empleamos a diario y, a pesar 

de estar en inglés, la recomendamos encarecidamente. Por ello lo incluimos en el disco de usuario 

ası ́como su correspondiente manual. 

MPLAB IDE consiste en un entorno que permite realizar, sin salir del mismo ni emplear otras 

herramientas software, todas las tareas propias del diseño de aplicaciones basadas en 

microcontroladores PIC. 

Sus caracterı́sticas y posibilidades más importantes se podrı́an resumir a continuación: 

• Completo editor de textos para la edición de los programas fuente. 

• Admite cualquier dispositivo PIC de cualquiera de las familias disponibles. 

• De forma natural integra el lenguaje ensamblador para todos los dispositivos PIC existentes. 

• Opcionalmente también puede asociarse y trabajar con compiladores de lenguajes de alto 

nivel (p.e. el C) de las firmas más prestigiosas. 

• Integra un simulador que permite simular la ejecución de un programa sobre cualquiera de 

los dispositivos PIC existentes: ejecución paso a paso, modificación/visualización de 

registros internos, puntos de ruptura y mucho más. 

• Acepta cualquiera de las herramientas hardware para la depuración, emulación y grabación 

que desarrolla Microchip: los depuradores ICD, los emuladores ICE2000 e IC4000 ası́ como 

grabadores como el PROMATE, PIC START PLUS y PICKit-2 compatible con nuestro PIC 

PROGRAMMER. 

En el presente documento no pensamos hacer un manual de usuario del MPLAB IDE. En el CDROM 

que acompaña a nuestro Grabador Universal PIC PROGRAMMER se incluye una copia original en 

inglés del manual que proporciona Microchip. 
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Lo que si haremos será un pequeño resumen de todas las operaciones relacionadas con la grabación 

de dispositivos mediante el empleo del nuestro PIC PROGRAMMER que, a todos los efectos, es 

compatible con la herramienta PICKit-2 de Microchip. 

4.1. INSTALACIÓN 
 

La instalación de MPLAB IDE es 

totalmente automática y no 

supone ninguna complicación. 

Basta con seguir paso a paso las 

instrucciones que van 

apareciendo. En la figura 4 se 

muestra la pantalla principal de 

MPLAB IDE para hacer una breve 

descripción de las opciones del 

menú principal.  

4.2. SELECCIÓN DE DISPOSITIVO 
 

Una vez que el MPLAB IDE está en ejecución, una de las primeras tareas a realizar será seleccionar 

el modelo de PIC con el que vamos a trabajar, que en nuestro caso será el PIC16F876A. En el menú 

principal seleccionamos Configure	⇒	 Select	 Device. Aparece una ventana como la mostrada a 

continuación. 
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En el desplegable “Device:” seleccionamos el modelos de PIC, en el ejemplo el PIC16F876A. 

Automáticamente veremos un resumen de herramientas tanto hardware como software que el 

MPLAB es capaz de soportar con el modelo recién seleccionado. Las señales de color verde indican 

herramientas disponibles. Las rojas representan a herramientas no disponibles en el MPLAB IDE 

para el dispositivo seleccionado. También pueden aparecer señales amarillas que indican que la 

herramienta en cuestión se encuentra en fase de testeo y no es definitiva. 

En el ejemplo hemos seleccionado el PIC16F876A. A la vista de la figura anterior podemos resumir 

qué herramientas puede emplear el MPLAB con dicho modelo. Cabe destacar que entre ellas se 

encuentra el grabador PICKit-2 que, como hemos venido repitiendo, es compatible con nuestro PIC 

PROGRAMMER. 

4.3. SELECCIONANDO EL GRABADOR 
 

Seleccionado el dispositivo (PIC16F876A) y suponiendo que el PIC PROGRAMMER está conectado 

a uno de los puertos USB del PC, elegimos ahora el tipo de grabador que vamos a emplear. En el 

menú principal seleccionamos Programmer⇒	Select	Programmer. Aparece un desplegable como el 

mostrado a continuación: 
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Vemos una lista de los sistemas de 

grabación que el MPLAB IDE puede 

emplear para grabar el dispositivo 

PIC16F876A seleccionado. En nuestro 

caso seleccionamos el PICKit-2 que es 

compatible con el PIC PROGRAMMER 

que disponemos en estos momentos. 

Inmediatamente el MPLAB trata de 

establecer conexión con nuestro PIC 

PROGRAMMER (compatible con PICKit-2). Si todo está va bien nos debe aparecer en la ventana 

“Output” una serie de mensajes como los mostrados en la figura, que nos indican que se ha 

localizado el PICKit-2, la alimentación es de 4.99V y que el PICKit-2 se encuentra listo y conectado. 

Si en el zócalo del grabador estuviera insertado el PIC elegido, también aparecerı́a el mensaje 

“PIC16F876A	 found	(b4)” indicando que dicho PIC ha sido identificado. En caso de que el PIC no 

estuviera insertado en el zócalo, aparecerıá el mensaje “PKWarn0003:	Unexpected	device	ID:	Please	

verify	 that	a	PIC16F876A	 is	correctly	 installed	 in	 the	application.	 (Expected	 ID	=	0xE00,	 ID	Read	=	

0x0)”. Esto nos recuerda que debemos insertarlo para poder proceder con las operaciones propias 

del grabador. 

4.4. FICHEROS HEX Y BUFFERS DE MEMORIA 
 

Los ficheros HEX son los que se obtienen tras el proceso de ensamblado y/o compilado de un 

programa fuente y cuyo contenido se grabará en las diferentes memorias del controlador. 

Efectivamente, el contenido de un fichero HEX puede estar compuesto de tres tipos de información 

que irán a parar a sus correspondientes memorias dentro del controlador: 

• Memoria de programa. Contiene el código hexadecimal de las instrucciones del programa 

que el controlador debe ejecutar. 

• Memoria de datos. Contiene información adicional o datos que se grabarán en la memoria 

EEPROM de datos del controlador. 

• Memoria de configuración. Contiene información sobre la configuración del controlador y 

valores de identificación. 

El MPLAB IDE dispone de otros tantos buffers de memoria. Cada vez que se ensambla o compila un 

programa fuente se genera el correspondiente fichero HEX y esos buffers se llenan con el resultado 

hexadecimal de ese ensamblado de forma que, posteriormente, puedan copiarse o grabarse sobre 

la memoria fı́sica del PIC. 
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Mediante la comando File	⇒	Import también es posible importar ficheros HEX procedentes de otras 

fuentes distintas a las generadas por el MPLAB IDE. Sea como fuere, cada vez que se abre un fichero 

HEX, los tres buffers de memoria del MPLAB IDE se llenan con sus correspondientes contenidos: 

memoria, datos y configuración, para su posterior grabación sobre el PIC. 

Los buffers del MPLAB también se pueden llenar manualmente con contenidos hexadecimales, 

mediante los correspondientes comandos: 

• View	 ⇒	 Program	 Memory: Permite visualizar y modificar el contenido del buffer 

correspondiente a la memoria de programa. 

• View	⇒	EEPROM: Permite visualizar y modificar el contenido del buffer correspondiente a 

la memoria EEPROM de datos. 

• Configure	⇒	Configuration	Bits: Permite visualizar y modificar los bits de configuración del 

buffer correspondiente a la memoria de configuración. 

• Configure	⇒	 ID	Memory: Permite visualizar y modificar los datos ID de identificación del 

buffer correspondiente a la memoria de configuración. 

Una vez hemos abierto u obtenido un fichero HEX, los tres buffers de memoria del MPLAB IDE 

contendrán la información necesaria que deberá grabarse en las memorias del controlador, tal y 

como veremos a continuación. 

4.5. FUNCIONES MÁS COMUNES DEL GRABADOR  
 

Cuando se ha seleccionado el tipo de grabador (PICKit-2 = PIC PROGRAMMER) y se ha realizado la 

conexión con él, se activan todas las opciones 

que se encuentra en el menú “Programmer” y 

que son propias de un grabador.  

La primera opción, “Select	 Programmer”, se 

empleó anteriormente para seleccionar el tipo 

de grabador que vayamos a emplear. En 

nuestro caso seleccionamos el PICKit-2 que es 

compatible con nuestro PIC PROGRAMMER. A 

continuación se detallan las opciones 

restantes.  

Program 

Realiza el proceso de grabación propiamente 

dicho. Copia los contenidos de la memoria de 
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programa, memoria de datos y memoria de configuración actual de los buffer del MPLAB IDE, sobre 

las correspondientes memorias fıśicas del controlador. 

Read 

Lee los contenidos actuales de las memorias de programa, datos y configuración del controlador y 

los deposita sobre los correspondientes buffers del MPLAB IDE. 

Verify 

Verifica que los contenidos actuales de las memorias de programas, datos y configuración sean 

idénticos a los contenidos de los correspondientes buffers del MPLAB IDE. 

Erase 

Borra todo el contenido actual de las memorias del controlador. 

Blank Check 

Comprueba que las memorias del controlador estén borradas. 

Read EEDATA 

Lee el contenido de la memoria EEPROM de datos del controlador y lo deposita sobre el 

correspondiente buffer del MPLAB IDE. 

Connect 

Restablece de nuevo la conexión con el grabador seleccionado, en nuestro caso el PICKit-2 

(compatible con nuestro PIC PROGRAMMER). Presenta una serie de mensajes como los que se 

mostraron en la figura 7. 

Download OS 

Actualiza el firmware interno del PICKit-2 (PIC PROGRAMMER). Esta operación puede ser necesaria 

cuando se descargue una versión actualizada del propio MPLAB IDE. 

Release from Reset 

Esta opción pone a nivel “1” la patilla MCLR del controlador. 

Hold in Reset 

Esta opción pone a nivel “0” la patilla MCLR del controlador. 
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Settings 

Con esta opción se abre una ventana 

similar a la mostrada en la figura de la 

derecha que permite activar o no una 

serie de procesos. En la pestaña 

“Settings” hemos elegido los dos que 

consideramos más importantes: 

• Conectar automáticamente al 

empezar. Cada vez que se 

selecciona el programador 

PICKit-2 (PIC PROGRAMMER) 

se procede automáticamente a 

la conexión con el mismo. En 

caso contrario hay que ejecutar 

manualmente el comando 

Programmer	⇒	Connect 

• Programar automáticamente 

el controlador si no hay errores 

de ensamblado/compilado. 

Esta opción es muy 

interesante. Cada vez que 

ensamblamos nuestro 

programa fuente, si no hay errores, se procede automáticamente a grabar el dispositivo con 

el ejecutable recién obtenido. 

En la pestaña “Warnings” tenemos la posibilidad de activar o no los mensajes y avisos que 

deseamos aparezcan si se producen determinados eventos. 

4.6. ICONOS DE GRABACIÓN 
 

La mayor parte de las opciones del menú “Programmer” se pueden ejecutar mediante una serie de 

iconos de acceso directo como los mostrados a continuación. 
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De izquierda a derecha su función se detalla seguidamente: 

• Program	the	target	Device: Programar el controlador 

• Read	target	Device	memories: Leer el contenido actual de las memorias del controlador 

• Read	the	target	EEPROM	memory: Lectura de la memoria EEPROM de datos del controlador 

• Verify	the	contens	of	the	target	device: Verificación del contenido del controlador 

• Erase	the	target	device	memories: Borrar las memorias del controlador 

• Verify	the	target	memories	are	erased: Comprueba que el controlador esté borrado 

• Bring	target	MCLR	to	Vdd: Pone MCLR del controlador a nivel “1” 

• Bring	MCLR	to	Vil: Pone MCLR del controlador a nivel “0” 

• Connection: Restablece la conexión con el PICKit-2 (PIC PROGRAMMER) 

 

5. EL SOFTWARE DE GRABACION PICKIT-2 
 

Se trata de otro programa de libre distribución, desarrollado por Microchip para su sistema PICKit2 

original que es compatible con nuestro grabador PIC PROGRAMMER. Se puede descargar y/o 

actualizar desde www.microchip.com. También está incluido en el cd que acompaña este 

programador. 

A diferencia del MPLAB IDE, este software está desarrollado para realizar, fundamentalmente, 

tareas de grabación y NO permite por tanto ni editar programas fuente, ni ensamblarlos, ni depurar, 

etc... Sin embargo admite la grabación de un mayor número de dispositivos PIC e incluye una serie 

de aplicaciones opcionales. 

5.1 INSTALACIÓN 
 

El grabador PIC PROGRAMMER se conecta directamente con uno de los puertos USB disponibles en 

el ordenador, mediante el correspondiente cable de interface incluido con el equipo. 

Inmediatamente es reconocido por Windows como un dispositivo de interface de usuario (HID) que 

se puede ver en Panel	de	Control	⇒	Sistema	⇒	Hardware	⇒	Administrador	de	Dispositivos. 
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El software de grabación PICKit-2 

se incluye en el CDROM. Basta con 

descomprimirlo e iniciar la 

instalación. Esta no presenta 

ninguna dificultad. Basta con 

seguir las instrucciones que vayan 

apareciendo durante el proceso.  

Su ejecución se puede realizar 

desde el Inicio	⇒	 Programas	⇒	

Microchip	⇒	PICKit	2 o bien desde 

el mismo icono de acceso directo 

que se crea en el escritorio tras la 

instalación. La figura de la derecha 

muestra el aspecto del programa. 

En ella se puede apreciar una 

ventana de estado en la que se nos 

informa que el PICKit-2 (PIC 

PROGRAMMER) ha sido 

localizado y conectado (“PICKit	 2	

connected”). Si además hubiera 

algún PIC insertado en el zócalo, 

éste será detectado (“PIC	 Device	

Found”), identificado y 

seleccionado (p.e. PIC18F4550). 

 

5.2 SELECCIÓN DE UN DISPOSITIVO 
 

Aunque en el zócalo ZIF de inserción nula del PIC PROGRAMMER sólo admite dispositivos de 8, 18, 

28 y 40 patillas de las familias PIC10, PIC12, PIC16 y PIC18, lo cierto es que tenemos a nuestra 

disposición el conector ICSP que transporta todas las señales necesarias para la grabación ICSP de 
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cualquier otro dispositivo de cualquier otra familia. Basta con realizar las conexiones necesarias 

según la siguiente tabla: 

 

# PIN SENK AL DESCRIPCIO� N 

1 VPP Voltaje de programación 

2 VDD Alimentación (5V) 

3 GND Tierra 

4 PGD Señal de Datos 

5 PGC Señal de Reloj 

6 AUX Señal auxiliar 

 

Esto es especialmente interesante dado que tanto el software como el hardware del PICkit-2 original 

(y por tanto nuestro grabador PIC PROGRAMMER) es capaz de grabar un gran número de 

dispositivos PIC de cualquiera de las familias existentes en la actualidad. 

 

En cualquier momento 

podemos seleccionar 

un dispositivo PIC de 

las diferentes familias 

existentes. Basta con 

selecciona la opción 

“Devide	 Family” del 

menú principal para 

que aparezca un 

desplegable como en la 

figura de la derecha, 

donde 

seleccionaremos la 

familia deseada.  
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Excepto si se selecciona la familia de gama baja 

(“Baseline”), que habrá que hacerlo siempre 

manualmente, en cualquiera de las otras familias 

se tratará de identificar el controlador PIC que en 

ese momento esté insertado en el zócalo, de forma 

inmediata y automática. 

Si se desea, esta selección también se puede hacer 

de forma totalmente manual. Basta con activar la 

opción “Manual	 Device	 Select” del comando 

“Programmer” del menú principal. A partir de este 

momento aparece una lista con los dispositivos 

admitidos según la familia seleccionada.  

En el ejemplo se ha seleccionado la familia PIC18F y en la lista “Select	Part” se selecciona ahora un 

miembro o dispositivo en particular (p.e. el PIC18F4550). 

Se supone que en el zócalo estará insertado el controlador adecuado. Si no fuera ası ́y, no hubiera 

ningún PIC insertado, o el insertado no es el mismo que el seleccionado, aparecerá el mensaje “No	

Device	Detected”. 
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5.3 IMPORTAR UN FICHERO HEX 
 

Como ya es conocido, cada vez que se ensambla o 

compila un programa fuente, se obtiene un fichero 

HEX que contiene la información que hay que 

grabar sobre la memoria de programa, memoria de 

datos y memoria de configuración del PIC. 

Mediante	File	⇒	Import	Hex se abre la clásica caja 

de dialogo que nos permitirá localizar el fichero 

HEX deseado. Una vez seleccionado cargamos su 

contenido sobre los buffers de memoria del 

software PICkit-2 para su posterior grabación 

sobre la memoria fı́sica del controlador.  

Tal y como se muestra en la figura, se aprecia que 

tanto el buffer de la memoria de programa como el 

de la EEPROM de datos, se llena con el contenido 

del fichero HEX recién leı́do o importado. 

El contenido de dichos buffers se puede visualizar tanto en hexadecimal como en ASCII y también 

se puede modificar manualmente. 

También tenemos acceso a la memoria de configuración haciendo click sobre “Configuration”. La 

figura muestra el valor actual, en binario, de la palabra o palabras de configuración del PIC18F4550 

tal y como se obtuvo al leer el fichero HEX de ejemplo. 
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Al igual que con los buffers de la memoria de programa como de datos, el buffer de la memoria de 

configuración también se puede modificar manualmente. 

Finalmente decir que también es posible crear y salvar un fichero HEX con el valor actual de los 

buffers de memoria del software PICKit-2, con todas las modificaciones realizadas sobre ellos. Basta 

con ejecutar File	⇒	Export	Hex para que se nos abra la clásica caja de diálogo para seleccionar 

carpeta y nombre del fichero HEX que vamos a guardar. 

5.4 GRABACIÓN DEL DISPOSITIVO 
 

Una vez insertado el PIC en el zócalo ZIF, seleccionado la familia y modelo del mismo e importado 

el fichero HEX, podemos proceder a grabarlo. Las tareas básicas están disponibles en los botones 

de la figura: 

 

Read: Permite leer la memoria del PIC y el contenido lo copia sobre los buffers de memoria del 

software PICKit-2. 

Write: Lee el contenido de los buffers de memoria del software PICKit-2 y lo graba sobre la memoria 

fı́sica del PIC. 

Verify: Verifica que el contenido de los buffers sea el mismo que el contenido del PIC 
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Erase: Borra tanto los buffers de memoria del software PICKit-2 como la memoria fı́sica del PIC 

Blank	Check: Comprueba que la memoria esté borrada. 

Pulsamos el botón Write para proceder a grabar el controlador con el contenido de los buffers, 

previo borrado del mismo. En la ventana de estado tendremos constancia del de si ha habido algún 

problema o bien el ciclo de grabación se realizó correctamente. 

También es posible actuar únicamente sobre las regiones de memoria que deseemos dentro del PIC. 

Efectivamente, en el la parte superior izquierda tanto del buffer de memoria de programa (Program	

Memory) como del buffer de la memoria de datos (EEPROM Data), disponemos de sendos 

“CheckBox” para habilitar (Enabled) o no el buffer correspondiente.  

 

5.5 VERIFICANDO EL DISPOSITIVO 
 

Esta función se ejecuta al pulsar el botón Verify. Consiste en comprobar que el contenido de las 

memorias o regiones del controlador coincide con el de los buffer de memoria del software PICKit-

2: memoria de programa, memoria de datos en EEPROM, memoria de configuración e identificación. 

Si se encuentra activada la opción Programmer	⇒	Verify	on	Write, todas las operaciones de escritura 

son verificadas automáticamente. 

En la ventana de estado aparecerá el correspondiente mensaje que avisa si hay o no alguna 

diferencia en la comprobación. 

5.6 LECTURA DEL DISPOSITIVO 
 

Esta función se ejecuta al pulsar el botón Read. Consiste en leer las diferentes regiones o áreas de 

memoria del controlador y copiarlas sobre los correspondientes buffers de memoria del software 

PICKit-2. Si la información leı́da es de todo ceros, es posible que el dispositivo estuviera protegido. 

5.7 BORRADO DEL DISPOSITIVO 
 

Esta función se realizar al pulsar el botón Erase. Provoca el borrado de todas las regiones o áreas 

de memoria del controlador empleando para ello el método “Bulk	Erase” en aquellos controladores 

en que sea posible. 
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Normalmente no suele ser necesario el empleo de esta función ya que cada vez que se graba un 

dispositivo, implica su borrado. 

5.8 VERIFICACIÓN DE BORRADO 
 

Esta función se ejecuta al pulsar el botón Blank	Check. Realiza una lectura de todas las regiones de 

memoria del PIC para comprobar que se encuentran borradas. 

5.9 PROCEDIMIENTOS AUTOMÁTICOS DE LECTURA/ESCRITURA 
 

En la figura 18 se muestran los dos botones que posee el software PICKit-2 

para realizar múltiples funciones cada vez que se actúa sobre cualquiera de 

ellos. 

Auto	Import	Hex	+	Write	Device	

Cada vez que se acciona aparece la clásica caja de diálogo de Windows gracias 

a la cual podemos localizar el fichero HEX deseado. Una vez seleccionado, 

automáticamente se procede a grabar el contenido del mismo sobre la memoria fıśica del PIC 

	

Read	Device	+	Export	Hex	File	

Cada vez que se acciona se lee el contenido actual de las diferentes regiones de memoria del PIC y, 

automáticamente, se guarda en un fichero HEX. 

6. DISPOSITIVOS ADMITIDOS 
 

En anteriores apartados ya se explicó el método a emplear tanto en el software MPLAB IDE como 

en el software PICkit-2, para seleccionar el modelo de PIC que queremos grabar con nuestro 

grabador PIC PROGRAMMER. Dichos métodos de por sı́ nos sirven para conocer qué dispositivos 

son admitidos por el grabador. 

El zócalo de inserción nula permite insertar cualquier dispositivo PIC de 8, 18, 28 y 40 patillas de 

las familias PIC10, PIC12, PIC16 y PIC18. Sin embargo también se pueden emplear las señales de 

grabación disponibles en el conector ICSP para realizar el interface de adaptación con cualquier otra 

familia e independientemente del número de pines. En general PIC PROGRAMMER admite todos los 

dispositivos PIC que admite el sistema PICkit-2 original de Microchip.  


